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For a complete guide to wildower photography...

For a complete guide to photographing wildowers, check out 
my ebook, Wildower Photography. In the book, you’ll learn all 
about setting up your shot, taking the shot, and then how to 
post-process your images in Photoshop. The book also includes 
twelve example photos, with complete stories about how 
those images were made.

Buy Now For Only $12.00!

Please feel free to share this ebook, but please do not modify any content.

All images and text Copyright © 2012 by Steve Berardi
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Wildowers display some of the most brilliant 

colors found in nature. And, for good reason– 

they’re ercely competing with each other to 
attract their pollinating friends: the insects and 

a few species of birds.

However, their brilliant colors often make them 

difcult to photograph. Have you ever come 
home with a full memory card only to nd out 

that all those beautiful ower photos you took 

have blown out highlights, washed out colors, 

and harsh shadows?

Well, there’s a secret to avoiding all these 

problems: photograph wildowers on an 

overcast day.

The clouds act as a natural diffuser of the Sun’s 
light, so when the sky is overcast, you’ll

get the most balanced natural light possible.

On the other hand, when the sky is clear, the 

bright sun will cast harsh shadows on owers 
which creates a problem for exposure (and 

usually results in blown out highlights, like in 

the photo on the right). Since the colors of 

wildowers are practically all highlights, this is 

a huge problem!

So, ideally, you’ll want to shoot your wildower 

photos on an overcast day. But, don’t worry if 

you can’t wait for the perfect light, you still 

have a few options (see the next tip).

1 How To Get Perfect Light
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What if you can’t wait for an overcast sky? Well, 
the next best thing you can hope for is a partly 

cloudy day. Then, wait until the sun goes behind 

a cloud before you shoot your photos. This won’t 

provide as good a diffusion as a completely 

overcast sky, but it will still get you great results.

For example, the wildowers of the Mojave 

Desert bloom for only a few weeks, and this 

desert rarely has an overcast day. So, in order to 

take the photo at the right, of a Desert Dandelion, 
I just waited until a few clouds blocked the Sun.

You also have another option to compensate for poor natural lighting: use an articial light 

diffuser. You can build your own in two easy steps. All you need is scissors, tape, a wire 

clothes hanger, and a shower curtain (make sure you get a semi-clear and non-tinted one). 
And, here’s how to build it:

1. Bend the wire hanger into a square or circular shape. You can do this just by pulling on the 

bottom of the hanger and bending it until you get a nice square shape.
2. Place the shower curtain over your bent hanger, and cutout a piece that is a little bigger 

than the wire frame. Then, just tape this onto the frame, and you’re done!

3. You should have something that looks like the photo below.

How to use your new diffuser

Using your new diffuser is easy–just hold it 
between the sunlight and the wildower you’re 

photographing. Make sure you’re holding it in 

such a way to diffuse ALL light that’s coming 

into the frame (not just the light that’s shining 

on the ower).

2 How To Control The Light
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Since the viewer tends to look at the sharpest part 

of the image rst, it’s important to try and make 
your owers as sharp as possible. So, here are a few 

tips:

(1) Always use a tripod. I know–tripods are heavy, 

they take a long time to setup, and can cost a 
lot of money, but it’s nearly impossible to get 

sharp photographs without one. Nothing keeps 

your camera more still.

(2) Enable mirror lockup. Normally, the mirror in 
your SLR will ip up immediately before the shutter opens, and this ip can make the 

camera vibrate a little. Enabling mirror-lockup (disabled by default on most cameras) 

will add a signicant pause between the time the mirror goes up and the shutter 

opens, letting any vibration die down before the photo is actually taken. Look in your 

camera’s manual to nd out how to enable this feature.

(3) Use a remote shutter-release or timer. The less you touch your camera, the less it will 

shake. When you press the shutter button on your camera to take a photo, there’s a 

good chance you’ll shake the camera a little. To prevent this, use a remote control to 

release the shutter, or you can just use the timer on your camera (so any vibration you 
caused by pressing the button will die down before the shutter is actually released).

(4) Shoot lots and lots of photographs. Because wildowers are so gentle, the slightest 

breeze can send the ower bouncing through the air. Taking lots of photos will help 

you capture the ower in between these movements.

(5) Use the sweet spot of your lens. Most lenses are sharpest in their “mid ranges.” For 

example, if your 70-200mm zoom lens has a speed of f/4, then you’ll probably get the 

sharpest results from using f/6.3 and zoomed at 135 mm. Very rarely are lenses sharp 

on their “fringes.” Also, xed focal length lenses are generally sharper than zoom lenses.

3 How To Get Sharper Images
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Getting a good exposure is extremely important in wildower photography, because if 

you try to correct the exposure too much in post processing, then you’ll lose a lot of detail 

in the ower’s petals. Luckily, with digital photography, we have tools like the histogram to 
help us nd that perfect exposure.

The histogram is an essential tool for determining digital exposure. If the word “histogram” 

brings back bad memories of boring lectures in math class, don’t worry: the histogram is 

pretty simple. It basically just shows the distribution of light and dark pixels in your image.

Here’s an example, with each axis labeled:

The left side of the graph shows how many dark pixels you have in your image, while the 

right side of the graph shows how many light pixels you have in your image. So, in this 

example, the image mostly has dark to midtone pixels.

At rst you may think that every image should have a balanced (i.e. bell curve) histogram, 

but this doesn’t always happen. It really depends on your image. For example, the 

histogram of a snow-covered landscape will mostly consist of bright pixels, so it’ll carry 

most of its weight on the right side of the histogram. But, a photograph of a black cat will 
mostly consist of dark pixels.

4 How To Get A Perfect Exposure
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So, let’s look at a real example. Here’s a photo of a Desert Five-Spot and its corresponding 

histogram:

At rst you might be confused: this is a ower, and it’s bright, so shouldn’t all the pixels be 

on the bright (right) side? Well, although this is a photo of a wildower, the ower actually 

takes up a very small part of the frame. Most of the background is actually quite dark, 
which takes up the majority of the frame.

This is just the regular histogram though. There’s actually another version, that’ll tell you a 

lot more about the exposure of your photos: the RGB histogram.

If you understand the regular histogram, then the RGB histogram is simple: it shows you 

the histogram of each individual color channel (red, green, and blue).

The bad thing about the regular histogram is that it lumps all these color channels 

together, making it hard for you to see if you’re underexposing or overexposing a specic 
color channel. And, on some cameras, the regular histogram only shows you the green 

channel, leaving you completely blind to the red and blue channels (which happen to be 

some pretty common colors amongst wildowers!).

So, the RGB histogram is similar to the regular histogram, but now you have a separate 
histogram for each color channel.
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The goal with the RGB histogram is simple: you don’t want to underexpose or overexpose 

any of the color channels, so look at each channel’s histogram to ensure the graph isn’t 

bunching up to one side and overowing off the graph. If you’re overexposing your image, 
then the histogram will show a line on the far right that extends all the way to the top of 

the histogram.

As an example, below is the RGB histogram for the same photo I showed earlier of the 

Desert Five-Spot:

Notice how the green channel doesn’t spread all the way to the right? At rst, you might 

think this means the image is underexposed, but remember: this is only the histogram of 

the green channel.

With the RGB histogram, your goal is not necessarily to get a balanced histogram in each 

channel, but instead to ensure you’re not losing details in any one of the color channels by 

underexposing or overexposing. 

Your goal is to keep increasing exposure (using longer shutter speeds), until the histogram 

is as far to the right as possible in at least one of the color channels.

So, although the green channel doesn’t have many highlights in this image, notice how 

the blue channel does: its histogram is spread out and nearly touches the right side. The 
important highlights in this image are in the blue channel, so that’s what I exposed for.

Many times you will have just one of the color channels spreading all the way to the right, 

while the others will be to the left or in the middle. The channel you should focus on is the 

one that’s farthest to the right. In this case, it was the blue channel.

For a step-by-step tutorial on how to use the histogram, check out my complete 
guide to wildower photography at:

http://photonaturalist.net/new-ebook-on-wildower-photography/
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A good background is essential for wildower 

photos, because it helps draw attention to your 

main subject: the ower. Here’s what a good 
background usually consists of:

1. Strong contrast with the ower

2. Smooth seamless color

3. Completely out of focus

The rst two properties are easy to accomplish: 

just look around until you nd a ower with a 

background that’s made of just one smooth color 

that contrasts well with the ower.

Then, to get those awesome blurry and out of 

focus backgrounds:

1. Use a lens with a long focal length
2. Maximize the distance between the ower and the background

3. Use a wide aperture (between f/5.6 and f/8.0)

For #1, you’ll need a telephoto zoom lens (a range of 100-300mm works well). The longer 

the focal length you use, the more blur/bokeh you’ll get. The long lens basically lets you 
isolate the ower against a very specic part of the background.

For #2, you may have to do a bit of searching for the perfect ower. Not only do you want 

to nd a ower with perfect petals and coloring, but the ower also needs to have a 

smooth and seamless background that’s far away (at least a few feet). This is much more 
important than #1, so don’t ignore this!

Lastly, make sure you use a wide aperture. Something like f/5.6 or f/8.0, depending on how 

much depth there is to the ower and the focal length of your lens (for longer focal 

lengths, use a smaller aperture, such as f/8.0).

5 How To Get A Perfect Background
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Every lens has a minimum focusing distance: the closest 

point where the lens can get a sharp focus. Generally, the 

longer the focal length of the lens, the greater the 
minimum focusing distance.

This becomes a problem with photographing wildowers, 

since you'll often use a telephoto lens to get that great 

background. And, since most owers are pretty small, you'll 
have to get your camera pretty close to ll the frame.

So, to get your lens to focus closer, use an extension tube.

An extension tube (pictured above) is a pretty basic piece of equipment: it’s just a hollow 
tube that extends the distance between the lens and the camera’s sensor. The more you 

increase this distance, the closer the lens can focus.

Extension tubes come in a variety of different sizes, from 12mm to 50mm, but the 25mm 

tube is usually the most useful. For example, if you put the 25mm extension tube on a 
Canon 70-200 F/4L lens, you can change the minimum focusing distance from 4.9 ft to 

about 4 ft! This 1 ft difference may not sound like much, but test it out in the eld, and 

you’ll surely be glad you have that extension tube.

You can also use an extension tube as a cheap way to turn your 50mm lens into a macro 
lens. If you add a 25mm tube to that lens, you’ll end up with 1/2X magnication (where a 

true macro lens would be 1.0X). As a rule, magnication equals the total extension divided 

by the focal length of the lens.

6 How To Focus Closer
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One of the most rewarding parts of nature 

photography is learning how to identify your 

subjects. When we place a name on 
something, it somehow makes us feel more 

connected to it.

When you rst meet someone, the rst thing 

you tell them is your name. And, so naturally, 
when we photograph something we haven’t 

seen before, we immediately want to know 

what it is.

But, it’s not always easy to identify wildowers. 

Sure, you may already know some of the more common species in your area, but what if 

you’re hiking down a trail and see this amazing ower for the rst time?

Well, there’s one thing you can do that’ll make it A LOT easier to identify that ower later:

Take photos from lots of different angles

Sometimes all that separates one species of ower from another is the shape of their 

leaves, or the presence (or absence) of little hairs on the leaves. And, these key features 
that help identify your subject are not always visible in the most artistic pose of your 

subject.

So, when you stumble upon a new ower, take that artistic shot rst, but then get some 

photos from different angles to help you identify the ower later.

7 How To Make Identification Easier
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Wildowers are gentle—very gentle. The 

slightest breeze can send them bouncing 

through the air. But, to get sharp photos, 
you need a still subject. So, how do you 

work with the wind to get that ower to 

stand still for just a second?

Well, you’re going to need some patience. 
Although there may be a strong breeze in 

the air, chances are that it will stop at 

variable times for just a few seconds. Be 

prepared when this happens.

Aside from waiting for that calm moment, here are a few other things you can try:

1) Use a fast shutter speed. To get a faster shutter, you can try using a higher ISO (200 or 

400), or using a wider aperture. It may be tempting to try and underexpose your shot to 

get an even faster shutter, but never underexpose when shooting wildowers. It’s 
impossible to recover those brilliant colors in post processing. Perfect exposure is 

absolutely necessary.

2) Use something to block the wind. Another way to help battle the wind is to have a 

friend hold up your homemade light diffuser or anything else that can help block the 
wind (like a jacket or shower curtain).

3) Take lots and lots of photos. Since the wind is so variable and your owers may only be 

still for a split second, it’s nearly impossible to anticipate these moments of perfect 

stillness. So, take lots and lots of photos to ensure you capture the ower at a moment 
between the breezes.

8 How To Battle the Wind
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Which of the two photos on 

the right do you like better?

They were both taken of 

the same ower, with the 

same camera settings. The 

only difference between 

the two shots is the 
position of the camera.

I’ll take a wild guess that 

you like the rst one more. 

And, I think this photo is better because it has more of an intimate and friendly feeling to it.

Now, part of the reason the rst photo has this intimate feeling is because the ower is 

more isolated from its background.

But, what’s more important here is the perspective: the rst photo was taken from a 
position looking directly at the ower (which stood just a few inches high). I was lying 

down on the ground with the camera on the same level as the ower, almost as if I was 

seeing eye-to-eye with the ower (if the ower had eyes, hehe).

The second photo was taken from a more elevated position: I was kneeling and looking 
down on the ower with my camera. When we look down on things, we tend to have a 

slight feeling of superiority or conquer, and this diminishes that friendly feeling.

The position of your camera in relation to your subject (whether it’s above, below, or 

on the same level), will determine the feeling you portray in your photo.

So, to create that intimate and friendly feeling in your nature portraits, you have to 

photograph your subject on their level. You have to see them eye-to-eye. Sometimes this 

might mean lying down on a bed of sharp rocks and being sore for a couple days, but the 

rewards are well worth it!

9 How To Create Intimate Images
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Okay, so this one isn’t really a tip for getting better wildower photos, but any time I talk 

about wildower photography, I feel it’s important to remind everyone to “leave no trace” 

when you’re out on a trail.

Leaving no trace means you leave the wilderness just as you found it (or maybe a little 

better by picking up any trash you nd). It means the only thing you take away is 

photographs, and the only thing you leave behind is footprints.

Here are a few tips for leaving no trace:

(1) Be careful where you step. Many plants require a specic soil structure to grow, so 

stepping on that soil can disturb the land and prevent further plant growth. Stay on the 

established trails as much as possible, and if you do venture off trail, then stay on stable 
surfaces like gravel.

(2) Pack out all trash. Whatever you bring in, you should also bring out. This includes 

things like toilet paper and anything else that’s “bio- degradable.”

(3) Clean your shoes and backpack before and after a hike. More and more invasive 

species are entering our wilderness, so to prevent them from spreading even more, 

make sure you clean your shoes and backpack before and after a hike. Their seeds can 

get stuck in the smallest crevices, so look carefully.

(4) Only clear dead vegetation and learn how to recognize “dead” stuff. When you’re 

composing a photograph, you’re bound to nd distracting objects in your scene and 

then be tempted to remove them. But, only remove the stuff that you’re certain is dead. 

And, learn to recognize what’s dead because in fragile places like the desert a lot of 

healthy living plants look dead.

As photographers, sometimes it’s easy for us to get absorbed in the image-making process 

and forget about the environment around us, but leaving no trace will ensure that the next 

visitor enjoys the same wildness you did, and that those owers will return next year.

10 How To Leave No Trace
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There are numerous ways to sharpen your images in Photoshop, but one of the most 

effective methods is High-Pass sharpening. It’s great because it doesn’t add much noise to 

your photos, and it’s a pretty quick process:

(1) You’ll need to have a at image for this, so if you have multiple layers, merge them 

together by selecting “Flatten Image” from the “Layer” menu.

(2) Create a duplicate layer by selecting “Duplicate Layer” from the “Layer” menu.

(3) Go to the “Filter” menu, and then under the “Other” menu, select “High Pass...”

(4) The goal here is to select a pixel radius large enough so it outlines the edges of your 

photograph and shows a little bit of color (make sure the “preview” box is checked). 
Usually values between 4 and 10 work very well. Here are a few examples of radius 

values that are too small, too big, and perfect:

(5) Click “OK” to apply the lter

(6) In the “Layers” window, click on the blending mode listbox, and select “Overlay”

(7) Your photo should now look like it’s too sharp. But, don’t worry, the next step is to x 

that! Right next to the blending mode listbox, there’s an “Opacity” slider. Click on that 

and lower the opacity until your photo looks sharp, but not too sharp. I usually set it 
between 30-45%.

11 How To Sharpen Your Images
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To make a wildower really stand out in your photos, you’ll want a dark background, so the 

bright colors of the wildower really jump out at the viewer. This is really easy to do in 

Photoshop, and here’s how:

(1) Use the “Elliptical Marquee” tool to circle your subject. If your ower isn’t circular, then 

you’ll need to use the lasso tool to outline it.

(2) Invert your selection by selecting “Inverse” from the “Select” menu.

(3) Add a new “Levels” Adjustment Layer by going to the “Layer” menu, then selecting 

“New Adjustment Layer” and nally “Levels”

(4) Make your selection darker by dragging the leftmost triangle towards the right (see red 
circle in screenshot below). The more you drag this triangle to the right, the darker your 

background will get. Stop when you’re satised, and click “OK”

(5) You should now have a dark background, but there’s probably a sharp outline between 

your subject and the background now. To get rid of this, go to the “Filter” menu and 

select “Gaussian Blur” under the “Blur” submenu. Start at 100 pixels and keep 
increasing the value until that sharp edge is gone and the dark background merges 

smoothly with your wildower.

12 How To Darken a Background

For more tips on nature photography, visit www.photonaturalist.com  

http://www.photonaturalist.com
http://www.photonaturalist.com


Sometimes the perfect exposure for the petals of a ower isn’t always the perfect exposure 

for other parts of the ower. So, in these cases you have to make a small increase or 

decrease in the exposure. Here’s how:

(1) Use the “Elliptical Marquee” tool to circle your underexposed area (which usually occurs 

in the center of owers). If your area isn’t circular, then you’ll need to use the lasso tool 

to draw an outline around it.

(2) Add a new Levels Adjustment Layer by going to the Layer menu, then selecting New 

Adjustment Layer and nally “Levels”

(3) Make your selection lighter by 

dragging the center triangle 
towards the left (see red circle in 

the screenshot to the right). The 

more you drag this triangle to 

the left, the lighter your selection 

will get. Stop when you’re 
satised, and click “OK” 

(alternatively, you may have to 

drag the rightmost triangle to 

the left instead of the center one, 

so try both!)

(4) Your underexposed area should now be properly exposed, but there’s probably a sharp 

outline between this area and the rest of your ower. To get rid of this, go to the Filter 

menu and select Gaussian Blur under the Blur submenu. Start at 0 pixels and keep 

increasing the value until that sharp edge is gone and the area merges smoothly with 
the rest of your wildower.

When using this method to make small adjustments to your wildowers, it’s important to 

do just that: make small adjustments. If you try to move those level sliders too far (i.e. more 

than 10 points), you’ll start blowing highlights and losing detail. Remember: it’s critical that 
you get a good RAW exposure.

13 How To Fix Underexposed Areas
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The 1-minute summary of this book

1. To get the best light, shoot on an overcast day

2. If you can’t wait for an overcast day, wait for clouds or use a diffuser

3. For sharper images, use a tripod, mirror lockup, and a remote shutter

4. Use a shutter speed that gets your histogram as far to the right as possible

5. Use a long lens and maximize the distance between the ower and background

6. Use extension tubes to get your lens to focus closer

7. Take photos from lots of different angles to help you identify the ower

8. Use a fast shutter speed, high ISO, and take lots of shots to battle the wind

9. Get down low to photograph the ower at its own level

10. Take only photos, and leave only footprints

11. Use high pass sharpening to make your images sharper

12. Emphasize the ower by darkening the background

13. Fix underexposed areas with a Levels adjustment layer
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To learn more about photographing wildowers, check out these helpful articles:

Sometimes Close-ups Are Better From Far Away
http://www.digital-photography-school.com/sometimes-close-ups-are-better-from-far-away

How to Use Your Tripod
http://www.digital-photography-school.com/how-to-use-your-tripod-its-not-as-simple-as-you-think

Why the Sharpest Photo Isn’t Always the Best Photo
http://photonaturalist.net/why-the-sharpest-photo-isn%E2%80%99t-always-the-best-photo/

How to Photograph Wildowers With Flash
http://photonaturalist.net/how-to-photograph-wildowers-with-ash/

9 Tips For Photographing Wildowers With a Point and Shoot Camera
http://photonaturalist.net/9-tips-for-photographing-wildowers-with-a-point-and-shoot-camera/

Evolution of a Nature Photograph
http://photonaturalist.net/evolution-of-a-nature-photograph/

Close-Up Photography With a Wide-Angle Lens
http://www.outdoorphotographer.com/how-to/shooting/close-up-wide-angle.html

Where To Learn More

This free eBook was brought to you by:

For more great tips on nature photography, please visit

www.photonaturalist.com
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For a complete guide to wildower photography...

For a complete guide to photographing wildowers, 
check out my ebook, Wildower Photography. In the 
book, you’ll learn:

‣ What equipment you need

‣ How to create good compositions

‣ How to choose the right aperture

‣ How to nd the perfect exposure

‣ How to maximize sharpness

‣ How to apply color theory

‣ How to get more depth of eld with focus stacking

‣ How to post-process your images with Photoshop

Also, learn by example with twelve example photos. Each example includes the 
camera settings that were used to create the image, as well as the complete story of 
how the image was made.

Buy Now For Only $12.00!
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Steve Berardi is a naturalist, photographer, software engineer, and 
founder of PhotoNaturalist—a blog about nature photography 
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in the beautiful mountains and deserts of southern California. His 
photos have been used by Nature Photographer Magazine,  the 
Sierra Club, and the National Wildlife Federation. He’s also written 
numerous articles for PhotoYou Magazine and the Digital Photo-
graphy School, the largest photography blog on the internet.

For more tips on nature photography, visit www.photonaturalist.com  
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